Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, dsPIC, FlashFlex, flexPWR, JukeBloq, Keeloq, Keeloq logo, Kleer, LANCheck, MediaLB, MOST, MOST logo, MPLAB, OptoLyzer, PIC, PICSTART, PIC® logo, RightTouch, SpyNIC, SST, SST Logo, SuperFlash and UNI/O are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

The Embedded Control Solutions Company and mTouch are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, BodyCom, chipKIT, chipKIT logo, CodeGuard, dsPICDEM, dsPICDEM.net, ECAN, In-Circuit Serial Programming, ICSP, Inter-Chip Connectivity, KleerNet, KleerNet logo, MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, RightTouch logo, REAL ICE, SQI, Serial Quad I/O, Total Endurance, TSHARC, USBCheck, VariSense, ViewSpan, WiperLock, Wireless DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestiC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2015-2016, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

Object of Declaration: Curiosity Development Board

EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
USA

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide for the EMC Directive 2004/108/EC (8th February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

Derek Carlson
VP Development Tools

12-Sep-14
Date
# Table of Contents

Preface ........................................................................................................................................... 7  
Introduction ...................................................................................................................................... 7  
Document Layout ............................................................................................................................ 7  
Conventions Used in this Guide ........................................................................................................ 8  
Recommended Reading .................................................................................................................... 9  
The Microchip Web Site .................................................................................................................... 9  
Development Systems Customer Change Notification Service ...................................................... 9  
Customer Support .......................................................................................................................... 10  
Revision History ............................................................................................................................. 10  

Chapter 1. Introduction to Curiosity  
1.1 Curiosity Development Board Kit Contents ............................................................................. 11  
1.2 Curiosity Development Board Layout ....................................................................................... 12  
1.3 Power Sources ......................................................................................................................... 13  
1.3.1 USB Connector (J2) ........................................................................................................... 13  
1.3.2 9V External Power Supply (J15) ....................................................................................... 13  
1.3.3 Variable External Power Supply (TP3, TP4) ....................................................................... 13  

Chapter 2. Getting Started  
2.1 Programming the Curiosity Development Board ....................................................................... 15  

Chapter 3. Troubleshooting  
3.1 The Demo Application Does Not Run ....................................................................................... 19  
3.2 The MCU Will Not Program Using The PKOB ........................................................................ 19  
3.3 The MCU Will Not Program Using the PICKIT 3 ..................................................................... 19  

Appendix A. Schematic  
A.1 Curiosity Development Board Schematic ................................................................................. 21  

Appendix B. General Notes  
B.1 Power ....................................................................................................................................... 23  
B.2 RN4020 Bluetooth® Low Energy (BLE) Module ...................................................................... 23  
B.3 Click or RN4020 Modules ......................................................................................................... 23  
B.4 Debugging Mode ....................................................................................................................... 23  
B.5 Routing and Flexibility ............................................................................................................. 23  

Worldwide Sales and Service ........................................................................................................ 24
CURIOSITY DEVELOPMENT BOARD
USER’S GUIDE

Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and documentation are constantly evolving to meet customer needs, so some actual dialogs and/or tool descriptions may differ from those in this document. Please refer to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each page, in front of the page number. The numbering convention for the DS number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the Curiosity Development Board. Items discussed in this chapter include:

• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity Development Board as a development tool to emulate and debug firmware on a target board. The document is organized as follows:

• Chapter 1. “Introduction to Curiosity” – This chapter contains general information regarding the Curiosity Development Board kit contents, layout and power source.
• Chapter 2. “Getting Started” – This chapter offers information on how to program the Curiosity Development Board.
• Chapter 3. “Troubleshooting” – Consult this chapter for troubleshooting information.
• Appendix A. “Schematic” – This appendix lists the Curiosity Development Board schematic.
• Appendix B. “General Notes” – Refer to this appendix for general notes on power options, configuration of the RN4020 Bluetooth® low-energy module and the Click module, debugging, routing and flexibility of the board.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

### DOCUMENT CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Arial font: | Referenced books | *MPLAB IDE User’s Guide*
| Italic characters | Emphasized text | *...is the only compiler...*
| Initial caps | A window | the Output window
| | A dialog | the Settings dialog
| | A menu selection | select Enable Programmer
| Quotes | A field name in a window or dialog | “Save project before build”
| Underlined, italic text with right angle bracket | A menu path | File>Save
| Bold characters | A dialog button | Click OK
| | A tab | Click the Power tab
| N'Rnnnn | A number in verilog format, where N is the total number of digits, R is the radix and n is a digit. | 4'b0010, 2'hF1
| Text in angle brackets < > | A key on the keyboard | Press <Enter>, <F1>

**Courier New font:**

| Plain Courier New | Sample source code | #define START |
| Filenames | autoexec.bat |
| File paths | c:\mcc18\h |
| Keywords | _asm, _endasm, static |
| Command-line options | -Opa+, -Opa- |
| Bit values | 0, 1 |
| Constants | 0xFF, 'A' |
| Italic Courier New | A variable argument | file.o, where file can be any valid filename |
| Square brackets [ ] | Optional arguments | mcc18 [options] file [options] |
| Curly brackets and pipe character: { } | Choice of mutually exclusive arguments; an OR selection | errorlevel {0|1} |
| Ellipses... | Replaces repeated text | var_name [, var_name...] |
| | Represents code supplied by user | void main (void) { ... } |
RECOMMENDED READING

This user's guide describes how to use the Curiosity Development Board. For the latest information on using other tools, refer to the MPLAB® X IDE home page: www.microchip.com/mplabx/. This resource page contains updated documentation, downloads and links to other MPLAB X compatible tools, plug-ins and much more.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

• **Product Support** – Data sheets and errata, application notes, sample programs and labs, design resources, user's guides and hardware support documents, latest software releases and archived software
Curiosity-Development-board specific product support can be accessed via our website at www.microchip.com/curiosity.
• **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
• **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, access the Microchip web site at www.microchip.com, click on Customer Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• **Compilers** – The latest information on Microchip C compilers, assemblers, linkers and other language tools. These include all MPLAB C compilers; all MPLAB assemblers (including MPASM™ assembler); all MPLAB linkers (including MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object librarian).

• **Emulators** – The latest information on Microchip in-circuit emulators. This includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• **In-Circuit Debuggers** – The latest information on the Microchip in-circuit debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICKit™ 3 debug express.

• **MPLAB IDE** – The latest information on Microchip MPLAB IDE, the Windows® Integrated Development Environment for development systems tools. This list is focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and MPLAB SIM simulator, as well as general editing and debugging features.

• **Programmers** – The latest information on Microchip programmers. These include production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included are nonproduction development programmers such as PICSTART® Plus and PICkit 2 and 3.
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the web site at:
www.microchip.com/support.

REVISION HISTORY

Revision A (July 2015)
Initial release of this document.

Revision B (April 2016)
Added the EU Declaration of Conformity.
Chapter 1. Introduction to Curiosity

The Curiosity Development Board supports Microchip’s 8-, 14- and 20-pin 8-bit PIC® MCUs. Dual-row expansion headers on either side of the socket offer flexibility of connectivity to all pins on the PIC MCUs. This board provides flexibility for experimentation through an application header with ground (GND) and supply voltage (VDD) connections. It also includes a set of indication LEDs, mTouch® button and push-button switches, and a variable potentiometer. Additionally, it features a Bluetooth® low-energy footprint and a mikroBUS™ footprint to accommodate a variety of plug-in Click™ Board sensors that can be used in application development.

1.1 CURIOUSITY DEVELOPMENT BOARD KIT CONTENTS

The Curiosity Development Board kit contains the following:
• Curiosity Development Board
• Quick Start Guide

FIGURE 1-1: CURIOUSITY DEVELOPMENT BOARD KIT
1.2 CURIOSITY DEVELOPMENT BOARD LAYOUT

Figure 1-2 identifies the major features of the Curiosity Development Board.

FIGURE 1-2: CURIOSITY DEVELOPMENT BOARD LAYOUT

1. USB mini-B connector (on back)
2. Footprint for 9V connector
3. Master Clear Reset button
4. 3.3/5V power jumper (J12)
5. Posts for external variable power supply
6. Expansion board connector
7. PIC® MCU socket for 8, 14, and 20-pin microcontrollers
8. mikroBUS™ Click Board footprint for application development
9. RN4020 Bluetooth® Module Footprint
10. Potentiometer
11. LEDs
12. mTouch® button
13. Push button
1.3 POWER SOURCES

The Curiosity Development Board can be powered in one of three ways, depending on its usage.

1.3.1 USB Connector (J2)

The USB connector (J2) will power the entire Curiosity Development Board. A shunt jumper must be placed onto jumper J12 (Figure 1-2). The right two pins of J12 will connect +5V from the USB connector J2. The left two pins of J12 will connect +3.3V from the USB voltage regulator on the back side of the development board. With USB power connected to J2, power LED D1 will always be ON to indicate that +3.3V is available on the board.

1.3.2 9V External Power Supply (J15)

The 9V external power supply (J15) will also power the entire Curiosity Development Board. A shunt jumper must be placed onto jumper J12 (Figure 1-2). The right two pins of J12 will connect +5V from the on-board voltage regulator circuitry connected to connector J15. The left two pins of J12 will connect +3.3V from the on-board voltage regulator circuitry. With 9V external power connected to J15, power LED D1 will always be ON to indicate that +3.3V is available on the board. Power LED D2 will only be ON when power (+3.3V or +5V) is applied to VDD via a shunt jumper placed on J12.

1.3.3 Variable External Power Supply (TP3, TP4)

A variable external power supply connected to TP3 and TP4 will power the entire Curiosity Development Board. A shunt jumper is not needed on J12, thus either +3.3V or +5V can be directly applied via a variable external power supply to VDD.
Chapter 2. Getting Started

The Curiosity Development Board must be used with MPLAB X Integrated Development Environment (IDE), available free on Microchip's web site, www.microchip.com. Use version v3.05 or later.

The Curiosity Development Board, through MPLAB X, is a low-voltage in-circuit debugger, as well as a low-voltage programmer, for all supported devices. In-circuit debugging allows the user to run, examine and modify programs for the supported device embedded in the Curiosity hardware. This facilitates the debugging of firmware and hardware concurrently. Use the Curiosity Development Board with MPLAB X IDE to run, stop and single-step through programs –breakpoints can be set and the processor can be reset. When the processor stops, the contents of the register are available for examination and modification.

2.1 PROGRAMMING THE CURIOSITY DEVELOPMENT BOARD

After connecting the Curiosity Development Board to the computer using the on-board USB connector (J2 on the back of the board), open the MPLAB X IDE. Then create a new project or open an existing project. Click on the Project Properties icon located in the project's Dashboard window (Figure 2-1). Alternatively, the Project Properties window can be opened by clicking on File > Project Properties, or by right-clicking on the project name in the Projects window and clicking Properties. (Figure 2-1).

FIGURE 2-1: SELECTING THE CURIOSITY DEVELOPMENT BOARD IN THE MPLAB® X IDE
MPLAB X refers to the Curiosity Development Board as “Starter Kits (PKOB)”, with “Curiosity” listed below. Click on Curiosity, the correct device and XC8 compiler version being used, then click Apply (Figure 2-2). On the upper left hand corner of the Properties window, click on Starter Kit (PKOB) (Figure 2-3). The window will change to the Options for Starter Kit (PKOB) window (Figure 2-3).
Select options category “Program Options” and then “Enable Low Voltage Programming,” if it is not already selected. Click **Apply**, then **OK** (Figure 2-3). Once the project is finished, the microcontroller is ready to be programmed. Simply click on the **Make and Program Device Main Project** button and the device will be programmed (Figure 2-4).

**FIGURE 2-4: PROGRAMMING THE DEVICE ON THE CURIOSITY DEVELOPMENT BOARD**

---

**Note:** When using the PKOB for programming, the Low Voltage Programming (LVP) bit of the Configuration Word(s) must be set (LVP = ON or ‘1’).
Chapter 3. Troubleshooting

This chapter discusses common operational issues and how to resolve them.

3.1 THE DEMO APPLICATION DOES NOT RUN

Curiosity Development Board must be plugged into a powered USB hub, computer, or other USB host device. To run the application, ensure the conditions listed below are met:

1. Start by plugging it into the USB device port, J2. LEDs D1 and D2 should light when VBUS is detected.
2. If D1 is not lit, verify that the USB host side port is functional.
3. If D2 is not lit, verify that jumper J12 is connected to the proper device voltage.

3.2 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity Development Board's PICkit on board (PKOB) uses low-voltage programming. The demo application code sets the Low Voltage Programming (LVP) bit to a '1', allowing low-voltage programming.

1. When using custom firmware, the LVP bit must be set to '1' in the Configuration Word. MPLAB X will not allow programming using the PKOB unless the bit is properly configured.
2. When using a PIC microcontroller (one not included with the Curiosity Development Board) that has already been programmed using high-voltage programming and the LVP bit cleared (LVP = OFF or '0'), the device will not be recognized and cannot be programmed using the PKOB. Reprogramming the device can be achieved by one of the following two methods:
   a) Connect a PICkit 3 Programmer to the Curiosity board, configuring MPLAB to use the PICkit 3 as the programmer, and ensuring the LVP bit is set to '1' in the Configuration Word. Reprogram the device.
   b) Use an unprogrammed (blank) device and ensure the LVP bit is set to '1' in the Configuration Word.

3.3 THE MCU WILL NOT PROGRAM USING THE PICkit 3

If the PIC device will not program using the PICkit 3, ensure that the 3.3/5V jumper (J12) is removed.
A.1 CURIOISITY DEVELOPMENT BOARD SCHEMATIC

FIGURE A-1: CURIOISITY DEVELOPMENT BOARD SCHEMATIC
Table A-1 lists the parts that are not included with the Curiosity Development Board.

<table>
<thead>
<tr>
<th>Item</th>
<th>Manufacturing Part Number</th>
<th>Manufacturer</th>
<th>Digi-Key Part Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J15</td>
<td>PJ-002BH-SMT</td>
<td>CUI Inc.</td>
<td>CP-002BHPJDTR-ND</td>
<td>CONN POWER JACK 2.5X5.5 mm HI CUR 2.5X5.5 mm HI CUR</td>
</tr>
<tr>
<td>U5</td>
<td>LM340MP-5.0/NOPB</td>
<td>TI</td>
<td>LM340MP-5.0/NOPBTR-ND</td>
<td>IC REG LDO 5V 1A SOT223</td>
</tr>
<tr>
<td>J33, J34</td>
<td>PPTC081LFBN-RC</td>
<td>Sullins Connector Solutions</td>
<td>S7006-ND</td>
<td>CONN HEADER FEMALE 8POS .1&quot; TIN</td>
</tr>
<tr>
<td>J7</td>
<td>PPTC081LFBN-RC</td>
<td>Sullins Connector Solutions</td>
<td>S7004-ND</td>
<td>CONN HEADER FEMALE 6POS .1&quot; TIN</td>
</tr>
<tr>
<td>J8, J10, J14</td>
<td>PRPC008SAAN-RC</td>
<td>Sullins Connector Solutions</td>
<td>S1011EC-08-ND</td>
<td>CONN HEADER .100&quot; SNGL STR 8POS</td>
</tr>
<tr>
<td>J13, J39, J40</td>
<td>PRPC004DAAN-RC</td>
<td>Sullins Connector Solutions</td>
<td>S2011EC-04-ND</td>
<td>CONN HEADER .100&quot; DUAL STR 8POS</td>
</tr>
<tr>
<td>J3, J4, J5, J6</td>
<td>PREC002SAAN-RC</td>
<td>Sullins Connector Solutions</td>
<td>S1012EC-02-ND</td>
<td>CONN HEADER .100&quot; SNGL STR 2POS</td>
</tr>
</tbody>
</table>
Appendix B. General Notes

B.1 POWER

When the Curiosity board is USB-powered though a 5V supply rather than a USB port on a computer, MCLR is held in Reset for approximately five seconds.

B.2 RN4020 BLUETOOTH® LOW ENERGY (BLE) MODULE

1. The RN4020 Bluetooth Low Energy (BLE) module must be configured before use. This can be achieved by either of the following methods:
   a) Connecting the UART TX and RX lines to an external UART-to-USB bridge, such as the MCP2200, and using a terminal program to communicate with and program the BLE module
   b) Writing custom firmware and programming the BLE module through the PIC MCU.

2. The Wake_HW line (pin 15 of the RN4020) was not connected, but is now recommended. This line must be connected for proper BLE functionality. See the RN4020 Bluetooth® Low Energy Module Command Reference User’s Guide (DS70005191) for more information.

B.3 CLICK OR RN4020 MODULES

Shared UART TX and RX lines supply connection to either the RN4020 BLE module or a Click module (which uses UART for communication with the PIC MCU), but not both.

B.4 DEBUGGING MODE

During Debug mode, LED D5 is not available to the user. This was done to provide out-of-the-box LED access to Microchip’s 8-pin MCUs. There are zero-ohm-resistors in series that can be removed to allow connection to another pin, if desired.

B.5 ROUTING AND FLEXIBILITY

Pinouts to the various connections provide connectivity to many devices. With zero-ohm-resistors in series to all connections, i.e., the mikroBUS™, TouchPad, and LEDs, the board can be modified for many situations without cutting the printed circuit board (PCB) traces.
# Worldwide Sales and Service

## AMERICAS

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Tel.</th>
<th>Fax.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Office</td>
<td>2355 West Chandler Blvd. Chandler, AZ 85224-6199</td>
<td>480-792-7200</td>
<td>480-792-7277</td>
</tr>
<tr>
<td>Technical Support</td>
<td><a href="http://www.microchip.com">http://www.microchip.com</a></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## ASIA/PACIFIC

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Tel.</th>
<th>Fax.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asia Pacific Office</td>
<td>Suites 3707-14, 37th Floor Tower 6, The Gateway Harbour City, Kowloon</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Tel: 852-2943-5100 Fax: 852-2401-3431</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australia - Sydney</td>
<td>Tel: 61-2-9868-6733 Fax: 61-2-9868-6755</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Beijing</td>
<td>Tel: 86-10-8569-7000 Fax: 86-10-8528-2104</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Chengdu</td>
<td>Tel: 86-28-8665-5511 Fax: 86-28-8665-7889</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Chongqing</td>
<td>Tel: 86-23-8960-9588 Fax: 86-23-8960-9500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Dongguan</td>
<td>Tel: 86-769-8702-9880</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Hangzhou</td>
<td>Tel: 86-571-8792-8115 Fax: 86-571-8792-8116</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Hong Kong SAR</td>
<td>Tel: 852-2943-5100 Fax: 852-2401-3431</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Nanjing</td>
<td>Tel: 86-25-8473-2460 Fax: 86-25-8473-2470</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Qingdao</td>
<td>Tel: 86-532-8502-7355 Fax: 86-532-8502-7205</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shanghai</td>
<td>Tel: 86-21-5407-5533 Fax: 86-21-5407-5066</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shenyang</td>
<td>Tel: 86-24-2334-2829 Fax: 86-24-2334-2393</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Shenzhen</td>
<td>Tel: 86-755-8864-2200 Fax: 86-755-8203-1760</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Wuhan</td>
<td>Tel: 86-27-5980-5300 Fax: 86-27-5980-5118</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Xian</td>
<td>Tel: 86-29-8833-7252 Fax: 86-29-8833-7256</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Xiamen</td>
<td>Tel: 86-592-2388138 Fax: 86-592-2388130</td>
<td></td>
<td></td>
</tr>
<tr>
<td>China - Zhuhai</td>
<td>Tel: 86-756-3210040 Fax: 86-756-3210049</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India - Bangalore</td>
<td>Tel: 91-80-3090-4444 Fax: 91-80-3090-4123</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India - New Delhi</td>
<td>Tel: 91-11-4160-8631 Fax: 91-11-4160-8632</td>
<td></td>
<td></td>
</tr>
<tr>
<td>India - Pune</td>
<td>Tel: 91-20-3019-1500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan - Osaka</td>
<td>Tel: 81-6-6152-7160 Fax: 81-6-6152-9310</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan - Tokyo</td>
<td>Tel: 81-3-6880-3770</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Korea - Daegu</td>
<td>Tel: 82-53-744-4301 Fax: 82-53-744-4302</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Korea - Seoul</td>
<td>Tel: 82-2-554-7200 Fax: 82-2-558-5932 or 82-2-558-5934</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malaysia - Kuala Lumpur</td>
<td>Tel: 60-3-6201-9857 Fax: 60-3-6201-9859</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Malaysia - Penang</td>
<td>Tel: 60-4-227-8870 Fax: 60-4-227-4068</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Philippines - Manila</td>
<td>Tel: 63-2-634-9065 Fax: 63-2-634-9069</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>Tel: 65-6334-8870 Fax: 65-6334-8850</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Hsin Chu</td>
<td>Tel: 886-3-5778-366 Fax: 886-3-5770-955</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Kaohsiung</td>
<td>Tel: 886-7-213-7828</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan - Taipei</td>
<td>Tel: 886-2-2508-8600 Fax: 886-2-2508-0102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thailand - Bangkok</td>
<td>Tel: 66-2-694-1351 Fax: 66-2-694-1350</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## EUROPE

<table>
<thead>
<tr>
<th>Location</th>
<th>Address</th>
<th>Tel.</th>
<th>Fax.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria - Wels</td>
<td>Tel: 43-7242-2244-39 Fax: 43-7242-2244-393</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Denmark - Copenhagen</td>
<td>Tel: 45-4450-2828 Fax: 45-4485-2829</td>
<td></td>
<td></td>
</tr>
<tr>
<td>France - Paris</td>
<td>Tel: 33-1-69-53-63-20 Fax: 33-1-69-30-90-79</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Dusseldorf</td>
<td>Tel: 49-2129-3766400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Karlsruhe</td>
<td>Tel: 49-721-625370</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany - Munich</td>
<td>Tel: 49-89-627-144-0 Fax: 49-89-627-144-44</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italy - Milan</td>
<td>Tel: 39-0331-742611 Fax: 39-0331-466781</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italy - Venice</td>
<td>Tel: 39-049-7625286</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Netherlands - Drunen</td>
<td>Tel: 31-416-690399 Fax: 31-416-690340</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poland - Warsaw</td>
<td>Tel: 48-22-3325737</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spain - Madrid</td>
<td>Tel: 34-91-708-08-90 Fax: 34-91-708-08-91</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sweden - Stockholm</td>
<td>Tel: 46-8-5090-4654</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UK - Wokingham</td>
<td>Tel: 44-118-921-5800 Fax: 44-118-921-5820</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

07/14/15